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Guide to the TallTimber Forest Inventory and Growth Processor
About this Manual
The front section of this document is intended to help people better understand and use
TallTimber. The last 20 pages strive to do the same for Timberpad Pro. Our goal is to provide
you with thoughtful instruction in a variety of formats, so that we communicate in a way that
is effective for you, putting you on a pathway to success in your timber inventory and growth
modeling. If you are struggling with a technical issue or just need some general feedback,
consider the below options for getting back on track. We want your computer time to be
productive, and suggest you keep this operator's manual nearby when questions arise. For a
Quick Start guide to TallTimber 4.0 Carbon, go to page 55.
Forms of Technical Support:
1. Operator's manual (this document)
2. Program itself has some instructions under the
icons.
3. Instructional videos on YouTube channel playlist (TTimber channel, Appendix C has link)
4. Website: www.ttimber.com
5. Email us: support@ttimber.com
6. Call us: 207.377.3956 or schedule a visit or a workshop for you or your group
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What is TallTimber 4.0 Carbon?
TallTimber is a computer application that provides forest products, carbon inventory and
growth & yield modeling reports along with spreadsheet ready, copy/paste output tables.
Earlier versions have been used to process and report on millions of acres of timberland
across the United States from Maine to California to Alabama. By forest products and carbon
inventory, we mean the characterization of the standing timber and forest carbon stocks by
whole tree components derived from a timber cruise dataset. The growth & yield modeling
relies on TallTimber's handy tool (TallTimber 2 FVS) that seamlessly converts the timber
cruise dataset into Forest Vegetation Simulator (FVS) input files, opens FVS for growth
modeling, and then brings FVS output back into TallTimber for additional reporting at the
stand/stratum or property level. In this way, the full functioning of TallTimber is to create a
professional report profiling the timber and carbon inventory while also including outputs of
future stocking and forest change (gross growth, mortality, net growth) as projected by FVS.
The first two thirds of this manual will be targeted towards describing this process, with the
last third describing the companion data collection software, Timberpad Pro. Figure 1 shows
a simplified characterization of TallTimber. The section titled TallTimber 4.0, Microsoft Access
(MS-Access) and Its Free Runtime Version is located near the end of this manual. Go there if
you are interested in learning about your computer's versioning and set up questions.
Individual or compiled
printer ready inventory
reports
Copy-Paste, spreadsheet
ready output tables
TallTimber-2-FVS system
producing growth reports
FVS ready input files for
more detailed modeling

Figure 1. Timber cruise data is imported into TallTimber 4.0, which then converts the data into a suite
of information products, including growth reports as a standard component of a regular inventory. It
also produces FVS-ready input files that can be stored and shared for further growth and yield
modeling efforts.
ttimber.com
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TallTimber 4.0 Input Data Formats (Videos 1 & 2 on Playlist)
TallTimber will accept and import cruise data from Excel spreadsheets and comma-delimited
text files. Those collecting datasets with Timberpad Pro may not need to read this section as
carefully as its text output is already in the correct format (see the Timberpad supplement at
the back of this document for more information on the comma-delimited file format). The
columns and order of data are identical whichever data format you use. Text files must end in
".txt", however.

Figure 2. This Excel dataset shows six points/plots and uses TallTimber's default species codes. Row 1
contains the required header fields, while row 2 has the first line of data. DBH (column E) is to the first
decimal place, but could be an integer value. The AGS/UGS field (column G) can be blank, but all other
columns must be filled out. Top DIB values must be 0 if no Top estimate is made, as opposed to null,
which is not allowed. Plot requires an integer value.
ttimber.com
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One item that is important when importing Excel datasets is that the data, including the
header row, must be made into a named-range called "Data" (again- only when the Excel
format). This named-range concept is just a tool within all versions of Excel that allows you to
reference a particular set of cells and give them any name you want. You can create a namedrange by selecting cells in Excel and then typing the name in the "Name Box" in the upper left
corner of the spreadsheet, located below the ribbon. Creating a named-range is quite easy,
you just need to do it once to get the hang of it, see Figure 2.

Figure 3. This dataset shows the same 6 points/plots as in Figure 2, except it has alpha species codes
and integer DBH values. Row 1 contains the required header fields, while row 2 has the first line of
data, the 0-tally point consistent with Figure 2. Alpha species codes must be remapped after the
dataset is imported into TallTimber the first time. TallTimber 4.0 will then retain your species code
settings if the "Keep My Codes" functionality is used.
ttimber.com
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Two examples of TallTimber datasets are shown in Figures 2 and 3. The Figure 2 dataset uses
TallTimber's default numeric species codes and has DBH entered to the first decimal point
(generally only important in growth modeling), while Figure 3 shows data with some alpha
codes and integer values for DBH. When using your own species codes, you are required to
map your codes to the TallTimber default codes after importing the data. It's a simple, onetime process and allows experienced timber cruisers to work with the same codes they may
have used in the past. See pages 11-12 for more information.
TallTimber is delivered with an example dataset. Excel format file headers can be copied and
pasted into new datasets for the Excel input data option. As mentioned, txt, xls, or xlsx files
will work with TallTimber's import routine. TallTimber-ready datasets do not have tree ID
numbers or the prism/plot size; this information is handled within TallTimber. Table 4 below
shows the format and length for each heading (column) in an Excel dataset, providing
comments for better understanding. An example of a text file section is shown on page 77.
Column
Heading
Type

Formats
Accepted
Text only

Max.
Length
26

Acres

Numeric

15

Plot

Integer Only

4

SPP#

2

AGS/UGS
Top

Integer or
Text
Numeric
Text or
Integer
Text
Integer

Reps

Integer

DBH
Product

2
14
1
2
2

Comments
Type, stand, strata or however plots get aggregated.
Common error is to use an integer only here.*
Area units are assumed to be acres. Decimal places
are allowed
Can be longer than 4, but FVS is limited to 4 characters
(9999)
Integer or alpha codes, either the default integers or
other codes defined by you
Integer or to one decimal place, 0.5 to 99 inches
Combinations of integers from 1 to 7, but can be text
formatted or a general number, no decimals.
"A" ,"U", "C", or "L", can be left blank
Diameter Inside Bark at the limit of merchantability, 0
is an option, cannot be null.
Rarely used, a multiplier for a given tree entry helpful
for plantations

Table 4. TallTimber datasets have nine columns (fields) with the headings shown above. All must be
filled in, except for AGS/UGS which can be blank. The Top field directs how TallTimber will calculate
the top diameter of the tree bole. If a non-zero value is entered, TallTimber will taper the end of the
tree to that value. When Top is set equal to 0, TallTimber uses taper rates to estimate the top DIB of
the tree. *The Type field cannot be a sole number, "Stand 1" is ok, while just "1" is not.
ttimber.com
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Remember, integers are whole numbers as compared to numbers with decimal places.
References to the word numeric in Table 4 means both whole numbers and numbers with
decimal places. When we say "text" format, we mean items that sort alphabetically and while
usually letters, can also be numbers that are treated as text. For example, when you have a
number in a text string, like in a stand type "H3B", they will be sorted as text. The product
field has numbers (1 to 7) that are combined into a string from 1 to 14 characters long. It can
be viewed as either a number or a string by Excel, as long as there are no additional
characters (no 0's or .'s). The contents will be a combinations of the characters 1 through 7.
TallTimber allows 2 product cruising methods; multiproduct and saw-pulp height. Popular in
many northern states, the multiproduct method requires cruisers to assess each 8’ section of
the tree from the stump to the limit of merchantability, as specified in the cruise design
associated with the field work. TallTimber 4.0 can use this approach, and accommodates up
to seven products and fourteen product sections in any order. TallTimber has a flexible
heading system, that allows you to create your own flexible labels for 4 board foot products
and 2 cord or ton based products. The seventh product is always cull. The saw-pulp product
mode simply has the cruiser enter the saw height and pulp height of the tree, and estimates
these two products only. This is fast, leaves out discriminating product calls, but may be
desirable in pine dominated cruising locales or when information on multiple products isn’t
important to collect. This style has a different input format for product data as is shown on
the bottom of page 8. Timberpad Pro data collection software allows both methods.
As stated above, TallTimber does not determine your specifications for a saw log or other
product, or what you call it. The standard reporting accommodates board foot units for
product codes 1-4, and cord/ton units for product codes 5-6. Additionally, the Grid Data
functioning within TallTimber also offers cubic foot estimates for product codes 1-4 and
cord/ton estimates for product 7 (cull). Grid Data buttons exist on the individual report form,
and allows you easy access to spreadsheet-ready tables of estimates for your own analysis
and development. Grid Data tables include columns for the log rule, the cubic foot volume
equation, and the conversion rate of cubic feet per cord. They can be copied and pasted into
a spreadsheet, or just exported directly to Excel via the "external data" tab if using the full
version of MS Access (people using Access Runtime will have the copy and paste option).
Board foot products are reported in 3 log rules; International 1/4", Scribner, and Doyle.
A closing comment on multiproduct cruising and TallTimber. Cruises can be designed many
ways, but when assigning products and heights to standing trees, there will be some level of
estimation error. Visibility may be restricted, defects are viewed from a distance and mostly
ttimber.com
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from below, and upper inside bark diameters are ocular guesses. One of the areas that is
also estimated occurs with partial sections, either at the top of the tree or somewhere else
along the products. Well run cruises will have an agreed upon system for handling these
factors, such as rounding down on the top section of the tree or rounding up on product.
Product
Section Code
1
2
3
4

Product Label
(Default)
Veneer
Sawlog
Pallet
Boltwood

5

Pulp

Cords, tons

6

Pot. log

Cords, tons

7

Cull

Cords, tons

Unit of Scale
Bd ft., cubic ft.
Bd ft., cubic ft.
Bd ft., cubic ft.
Bd ft., cubic
ft., cords, tons

Comments on Individual Section Codes
Highest grade products, rotary/slicer logs
Generally grade 2 or better quality
Generally a number 3 or lower grade log
Also has been used as peeler or flooring
log, small diameter with high quality is
typical
Section that has no potential for grade
appreciation
Section that is pulp because of size
alone, also defined as growing stock
sections in some cruises
Cull estimates only available as Grid Data
output

Table 5. Product codes used in column F will be interpreted by TallTimber as shown, with
units of measure listed. The Grid Data functionality is where cull values (code 7) are available.

Converting Height-Style Data Into TallTimber Format - An Important Reminder!
This format discussion ends with a description of how you can format data collected with
heights alone into TallTimber ready input. We have worked with many styles and structures
of timber cruise data and understand that everyone doesn't use the multi-product format.
TallTimber accommodates those datasets as well, which is how it successfully imports
Timberpad data collected in Saw-Pulp Height mode. Here's how it works.
If you have the height above the ground at which saw material ends and the height of where
pulp material or merchantability ends, you have enough information. The coding works as
follows and results in a single, 6-character string. The number "9" is used to signal this format
style. We show it below for 1) a tree with 57 feet of pulp only, 2) a tree with a 25-foot saw
height and a total merchantable height of 57 feet, and 3) a cull tree with no sawlog or pulp
material. The merchantable lengths are limited to 2 digits, or 99 feet.
1) Tree with pulp only: 9, 00, 9, 57 = "900957" is the PRODUCT value
2) Tree with both saw and pulp: 9 , 25 , 9 , 57 = "925957" is the PRODUCT value
3) Tree with cull only, non-merchantable: 9, 00, 9, 00 = "900900" is the PRODUCT value
ttimber.com
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Working with TallTimber: Step 1. Import Data (Video 3 on Playlist)
TallTimber has a five-step main menu that leads you through the steps necessary to create
and compile your own self-titled, inventory reports. This may or may not include growth
report production using the US Forest Service's FVS growth model. In the case where no
growth modeling is done, it is a four-step process as can be observed on the main
switchboard shown in Figure 6. While it is not as simple as just clicking four or five buttons, it
is surprisingly simple to produce reports or access tables of spreadsheet ready output. There
are checks in place along the way to help you stay in touch with the process. Let's start by
following Step 1: Import Data.
Clicking the import button located under “Start” opens a File Explorer window which lets you
navigate to the Excel spreadsheet or text file where your data resides. Select the appropriate
input file with your mouse and the File Explorer will close, followed by the import process.
You will be notified of success with a message box titled “Successful Import and Reminder”.
The reminder is that either the default settings within TallTimber have been restored, or that
your prior specifications have been maintained, as described in the next paragraph.

Figure 6. Importing your field tally into TallTimber uses the Windows File Explorer as shown above.
Your data can be in Excel spreadsheets with versions from Excel 97 to current, or comma-delimited
text. Successful imports conclude with a Message Box telling you that is was successful and reminding
that either default settings were restored or your codes have been maintained. You also may be
notified of formatting problems that need to be resolved.
ttimber.com
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The settings we speak of here are related to species codes, wood density modifications
(pounds per cubic foot), cubic feet per cord, product merchandizing, and other options in
Step 2. If you have modified these settings and want to keep your adjustments, you can tell
TallTimber this by checking the "Keep My Codes" box on the TallTimber Inputs form (Step
2) shown on the following page. The dialogue box appearing after the Step 1 Import reacts
to whether this box was checked or not.
Keep in mind Table 4 when trying to diagnose a data format error. It is ok to have alpha
species codes, but blank or alpha diameters won’t work. Type names must be in text format,
not numeric alone ("H3B" is okay, while "3" alone is not okay as number format). Remember
to check the example spreadsheet data provided in the setup package and the 0-tally format.
Lastly, remember to get the column headings named correctly when using the spreadsheet
input file format. The best way to do this is by copying and pasting from the example
spreadsheet file into your own new input file.

ttimber.com
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Working with TallTimber: Step 2. Enter Input Parameters (Videos 4-6 on Playlist)
The Inputs form (largest image in Figure 7) is where you enter specific cruise information,
shaping the inventory to conform to the standards you choose for the dataset being
processed. The only setting that is required is the sample point basal area factor (BAF) for
variable-radius points, or the plot size for fixed-radius plots and 100% tally sampling (Item 1
on Inputs form). Be aware that individual datasets are not allowed to use varying BAFs or plot
radii across plots, the entered BAF or plot size is for the entire overstory.

Figure 7. Step 2, Input Parameters, occurs after importing your data. To initiate 100% tally sampling,
set the fixed-radius plot size equal to the Acres field value in the input data. For example, a 7-acre
patch of 100% tally timber would have both Acres and Plot Size set to 7.
ttimber.com
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If multiple prism BAFs or plot sizes were used amongst your dataset for overstory trees, you
will need to split the data and process the datasets individually as separate inventories. If
different species codes are used, TallTimber will instruct you to “map” the species codes
before a BAF or plot size can be successfully entered. Mapping codes is either typing or
pasting your codes in a provided column. These and other modifications are described here
and on the next page (also shown on the YouTube playlist).

Figure 8. The second item on the Inputs form allows control of species codes and other species
values. You can preserve your choices for future inventories via "Keep My Codes."
ttimber.com
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As mentioned on page 10, TallTimber accommodates differing species codes, lower stem
taper (through Girard Form Class), density values, and order of appearance in reports. These
changes are species level modifications and are accessible through Item 2 in the Inputs form,
located in the Optional Settings section. Clicking Item 2 allows you to work with the
Modifications form, seen in Figure 8. Differing species codes can be "mapped in" by either
typing each code in for the 62 different species codes, or simply copying and pasting a
column from a spreadsheet where you have your own species codes stored into the
Modifications form. Similarly, you can have different densities, form class or sort order stored
in columns in your own spreadsheet which can be copied and pasted into the modifications
form. The density (pounds per cubic foot) values are converted into tonnage estimates based
on the net cubic feet per cord value used.
With Item 3 on the Inputs form, TallTimber accepts a fixed-radius regeneration plot (subplot)
entered along with the typical overstory point or plot. From a data structure standpoint,
these understory trees are simply included in the dataset just like any other trees. Their
diameter is required to be smaller than the lower merchantable limit of the overstory trees.
The default for this limit is the 5” diameter class, or trees from 4.6” to 5.5” DBH would be
considered as trees having merchantable volume. This lower limit along with the expansion
factor for that fixed-radius subplot can be changed up or down by clicking Item 3 on the
Inputs form and working with the Merchantability and Regeneration form shown in Figure 9
(page 14). These values are changed in one of two controls. The minimum diameter class is
set by a combo box (drop down) with a default value of 5, while the expansion factor is set
with a text box. A 1/500-acre fixed-radius subplot would have an entry of 500, the trees per
acre for an individual sapling or seedling. The default of 1, means no change from the BAF.
TallTimber uses a default of 85 net cubic feet per merchantable cord, a common assumption
for a cord of wood in the Northeast (net means that bark and voids are deducted from the
128 cubic foot gross cord). The fourth item on the Inputs form allows you to modify that
assumption. This standard varies across regions, and can be impacted by the softwoodhardwood mixture and the common diameter size of wood being sold. Like other units of
measure, much of its validity is simply based on past usage and conformity to a standard that
people have tacitly agreed to over time. People in the Lakes States commonly use a 79 net
cubic foot cord standard, and we’ve seen softwood dominated regions use a 90 net cubic
foot standard. TallTimber’s 85 cubic foot assumption can be changed by entering a different
value in a combo box as shown in Figure 10 (page 15), but it resets to that standard whenever
a new dataset is imported. It also opens a popup window whenever the net cubic foot
volume per cord form is closed to confirm any changes made, making these changes
purposeful and evident. Lastly, every TallTimber report has the cubic feet per cord
assumption printed on it as a last measure to avoid confusion and promote clarity. Checking
Keep My Codes preserves this setting as well as the others mentioned.

ttimber.com
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Figure 9. The third item on the Inputs form controls the minimum DBH class for merchantability along
with the expansion factor to be used for trees below the minimum diameter class. There are two
input controls that you work with in this regard. You can change either one or both, depending on the
specifications.
ttimber.com
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Figure 10. The fourth item on the Inputs form accommodates changing the cubic foot per cord
assumption, which is 85 by default, and resets whenever a new dataset is imported. This is an
optional change.

ttimber.com
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TallTimber processes section data for each individual tree, and provides options as to how
this is done. One of these options is "log length preference" and it is important because it
impacts the board foot volume estimates produced. Because the scaled yield of a log is
limited by the diameter of its small end, scaling two contiguous 8-foot logs individually will
produce a different board foot estimate than if scaled as a single 16-foot log unless they
taper as the log rule assumes. More specifically, there is less slabbing deduction applied by
Doyle and Scribner log rules when scaling two individual 8-foot sections as compared to when
they are scaled combined into a 16-foot log (these rules assume a straight cylinder). Of the
three TallTimber log rules, the impacts tend to be greatest for Doyle, then Scribner and least
for International ¼”, which assumes 1/2" taper per 4-foot section. The impact of this choice
varies by inventory, but can be quite substantial for Doyle and Scribner log rules.
TallTimber provides you a choice of two “log length preference” modes as shown as the fifth
item on the Inputs form (Figure 11). The default is shown as “16’ if possible” while the
alternative is shown as “8’ always”. The default, 16’ if possible, is also called “merchandizing
mode” because it seeks to make 16’ logs when it can. For example, in the default mode a tree
with a product code of 1223555 (a 7-section tree with “veneer-saw-saw-tie-pulp-pulp-pulp”

Figure 11. Board foot merchandizing is the fifth option on the Inputs form. This choice is related to
how TallTimber applies log rules internally, and is in “merchandizing mode” (16-foot if possible) by
default. The “8’ always” choice produces significantly more volume in Doyle and Scribner rules.
ttimber.com
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products and 56 feet of merchantable bole) will have the 2nd and 3rd sections scaled as a
single, 16-foot log. The first and fourth sections (veneer and tie/pallet, respectively) are
scaled as 8-foot logs as they have no adjacent sections of similar product. The other option,
“8’ always”, takes each section independently and produces estimates as if each section were
bucked into individual 8’ bolts. Additional log length preference help can be accessed by
clicking on the icon shown in Figures 11 and 12 by the Log Length Preference box.
Traditional forest mensuration literature1,2,3 profiles a variety of methods to estimate the
cubic volumes of felled or standing trees. Basic discussions cover the idea of estimating bole
volumes as approximations of more uniform geometric solids, applying the formula of log
cross section area times log length to estimate solid volume. Of course trees aren’t uniform,

Figure 12. The cubic foot volume equation option is listed as the 6th item on the Inputs form. It
provides cubic volume equation choices aligning with formulas from the forestry literature. Smalian’s
equation is the default. The 7th item allows reports to have different product headers as described on
page 18. Clicking the “Modify Headers…” button opens a table where you can enter new heading(s).
1

Clutter, et al. 1992. Timber Management: A Quantitative Approach. Kreiger Publishing, Malabar, Fl.
Avery, T.E. and H.E. Burkhart. 1994. Forest Measurements. McGraw-Hill Inc., NY.
3
Forestry Handbook: 2nd Edition, edited by Karl Wenger for the Society of American Foresters. 1984.
John Wiley & Sons, NY.
2
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and getting the true average cross section area is generally impractical because it would
require taking many slices of the tree section being measured. The three formulas most often
referenced are Huber’s, Newton’s and Smalian’s. Smalian’s is the most commonly used as it
does not require a midpoint measurement and its bias can be mitigated by keeping bole
sections short. The 6th item on the Inputs form provides the three equations as options for
computing cubic foot volumes, with Smalian’s used as the default. This choice is printed on
each report page. Additional help can be found by clicking the icon shown in Figure 12
(previous page), by the Cubic Volume Equation box.
The seventh option, “Modify Headers on Tabular Reports”, is lastly shown in Figure 12.
Located near the bottom of the Input form, this option was added to the version 4.0 Carbon
release. It allows you to change the product headings printed to the tabular style product
reports produced by TallTimber. This facilitates the use of differing product names than the
defaults typically shown on individual or combined tabular reports. For example, you might
prefer to change product from the default “Boltwood” to “Mat Log”. Similarly, you might
prefer to use product 6, by default “Pot. Log”, to “Firewood”. The new flexibility allows the 4
board foot products and 2 cord/ton products to be renamed other appropriate board foot
and cord/ton products. As a reminder, products 1-4 will continue to be processed as board
foot products and 5-6 processed as cord/ton products.

Working with TallTimber: Step 3. Check Input Success (Video 7 on Playlist)
We’ve built TallTimber in a way that allows some checking to make sure the data has been
imported properly, a measure twice and cut once mentality. Step 3 is where you can take the
time to make sure the data is being represented correctly. Clicking on Step 3 opens the
Profile Report, a report on the partially completed data workup. It allows operators to scroll
through the strata, making sure they are named correctly and have the correct number of
acres and points. For example, a typo of a stand/stratum name on one tree record in the
spreadsheet data will result in a new, erroneous stand/stratum. The Profile Report mitigates
the chances of these types of mistakes, but it is optional.
The following idea is important enough to us that we want to give it its own paragraph and
this somewhat awkward topic sentence. The Profile Report shows how many 0-tally points
are in the dataset. This insight is a critical piece as 0-tally points are generally among the most
influential points in any stratum, and often any cruise. Moreover, 0-tally points are often
where mistakes are made when datasets are shared electronically and communications
falter. On industrial-size cruises, it’s good practice to keep track of this information, as it
helps understand how the sample frame treated non-forest and was deployed to the real
world sampling of roads, yards, and water conditions where 0-tally is common.
A minor point regarding the column titled “# of Tree Records”. This column is a count of rows
in the spreadsheet dataset for a given stratum or stand, which contrasts with the columns
“Max Trees/Point” and “Min Trees/Point” which account for the Reps value. For example,
ttimber.com
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a point may have eight tree records, but twelve trees if there was a Reps field value of 5 in
one of the tree records (7 x 1) + (1x5) = 12. While sparingly used, Reps is helpful to cruisers in
plantations and softwood thickets where a cluster of trees of the same species, diameter, and
product exists on the same point. Max and Min capture the tally spectrum.
Lastly, for cruises with five or more strata, it will be necessary to scroll down the report to
view them all. With more than four strata, the scroll bar should appear on the right hand
margin, but can be missed until operators get used to viewing the report. Figure 13 shows an
example with four strata, so the scroll bar is not present.

Figure 13. The Profile Report provides broad stratum or stand level metrics related to the input
dataset. This is an optional, but suggested, step on the way to producing reports.
ttimber.com
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Working with TallTimber: Step 4. Process & Get Results (Videos 8-9 on Playlist)
TallTimber is built in a fashion that allows two different mindsets with respect to getting
information out of it. This is the result of how our projects have generally worked out. There
are situations when you want to view a single report, pop in and out of different reports, or

Figure 14. Individual Report mode allows quick access to single reports or copy/paste table output.
ttimber.com
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just work with the Grid Data output in a spreadsheet on your own. That is what we call
Individual Report mode, and fits well when you have less time and may revisit the inventory
later on. There are other times when you want to create an inventory report masterpiece,
the final report you present your client or create for your own file. This style of report has a
cover sheet, a second page with codes and assumptions, and then a compilation of all the
sub-reports you find important enough to include. This is Combined Report mode and uses
what we sometimes call the compiler. The next few pages take you through Step 4, which is
about producing output with TallTimber in either Individual Report or Combined Report
modes. Figure 14 (previous page) shows Individual Report mode used to create a report.

Figure 15. Individual Report mode allows operators to quickly access tabular information as shown
above. This can be directly exported or copied and pasted into other documents.
ttimber.com
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Whether using Individual Report mode or Combined Report mode, the choice of log rule is
determined by the tab chosen on the form titled Report Selection (shown in Figures 14 & 15
previous pages). When the Report Selection form opens, the International ¼” tab is selected
by default. Operators can easily change this by clicking on the tab for Doyle or Scribner log
rules also visible on the Report Selection form.
Individual Report mode has 72 different reports available in each of the three log rules,
among which are eight pie charts and eight bar charts. Additionally, Individual Report mode
provides a button for producing table data associated with 30 of the 72 reports, one of these
tables is shown at the top of Figure 15. The tables can be copied and pasted into a
spreadsheet, or directly exported using the External Data menu located on the MS Access
ribbon. These tables have several pieces of information not available in the printer ready
reports. For example, some tables provide sawn products in cubic foot volumes along with
board foot, and cull volumes (associated with the product = 7 code) are also available. These
tables provide accessible material for further analysis, charting and development to meet
your unique needs.
Combined Report mode provides two flexible input forms that help you create a master
report (an inventory document with multiple tables & charts). First, the Report Builder form
allows you to include and order the subreports for your master report. There are 74
subreports to choose from among four tabs on the Report Builder form. Up to 15 of the 74
subreports can be selected and put in the desired order of presentation. Secondly, the
Personalization form allows pictures and logos to be entered on the cover page, along with
titles and subtitles as shown in Figure 16 (next page).
The Personalization form also has an option (#5) of including a subreport including Common
Practice carbon levels for one of the lower 48 states. These Common Practice levels are
output by “Supersection” and “Asssessment Area”, carbon offset protocol terms used to
compartmentalize area and forest types within that area. To include that subreport, you click
on a state from the list box and then select the “Add CP info to report” checkbox. These levels
are provided by California EPA Air Resources Board (ARB) for carbon offset forest projects
and get printed to the beginning of the report for those wanting to compare their forest’s
carbon levels to the current ARB Common Practice. This is just an option, and does not print
out if not selected.
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Figure 16. Combined Report mode allows building compiled sub-reports in the sequential order of
your choosing, along with personalized business logo and imagery for the cover.
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The functioning of the Report Builder in Combined Report mode is built to be instinctive, and
has a similar layout structure as the Individual Reports form, but there are some obvious
differences. The Report Builder is a 4-tabbed form that has blank text boxes made for
entering numerical values corresponding to the order that you want your sub- reports to be
shown in.
Choosing a report means entering a number in the text box next to it, as reports with blank
text boxes will not be included. This entering process occurs over the 4 tabs titled “Stand and
Stock”, “Charts”, “MBF, Cords, Tons” and “Carbon” as shown in the center of Figure 16 (page
23), where the “MBF, Cords, Tons” tab is selected and 10 reports are ordered from 1 to 10.
For the sake of completeness, we point out that it would be possible for more than 10 to be
selected as you can only see one tab in Figure 16. Reports 11 to 15 could be selected on the
“Stand and Stock”, “Charts” or “Carbon” tabs. In summary, 15 reports of the 74 possible can
be included into a combined report, and TallTimber will sort them according to the numbers
ordered in the text boxes with empty text boxes excluded from the master report. Reports
can be in units of green tons or cords or both for low grade products.
After using TallTimber, you will likely settle in to a certain selection and order of reports that
become your preferred standard master report. In anticipation of this, TallTimber stores and
retrieves the reports and order from the last master report produced. These values are
automatically filled in the text boxes when the Report Builder is next opened. If a different
combination of reports is desired, you can easily clear the text boxes by clicking the Trash
icon

on the Report Builder form. This erases the data in the text boxes on all 4 tabs. If

the trash icon is clicked inadvertently, the Undo Arrow icon
the erased values.

can be selected to bring back

The top of Figure 16 shows how the Personalization form, described earlier, allows operators
to customize the master report cover page, along with the resultant report to its right. These
customizations are optional entries. Operators do not have to add values to the empty text
boxes for titles and the other fields, they can simply click the “Compile and View” button to
create the report with a generic cover page. This is not a bad approach until you have settled
into a definite selection of reports and order. Filling out the Personalization form is generally
saved for the final version or versions to be printed or otherwise saved. Once the master
report is created it can be printed to a pdf, a paper version, or whatever print format
currently installed on operators' systems. Closing the master report returns you to the Report
Builder form.
The forms shown in Figure 16 also show the stepwise path typical of how you can back out of
different locations within TallTimber. All the forms beyond Start have a Return button that
allows you to retreat from your location one step at a time, which is the way we suggest
people maneuver within TallTimber. The actual master report has a close button in the upper
right hand corner, as is common with MS Windows programs.
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Carbon Reporting
New to version 4.0 is carbon reporting. The carbon reports are an extension of the existing
reporting form structure, with 2 additional tabs added to the individual report form (Figure
17), and a single tab added to the combined report form. These additional tabs accommodate
16 new carbon reports and extra grid data buttons for directly exporting table output to your
spreadsheet. The 2 additional tabs within individual report mode offer carbon per acre and
total carbon output as computed by the Jenkins, et al method published in Forest Science
(2003), with additional information provided by the United States Forest Service GTR NRS-88
(2011). The carbon calculations within TallTimber start with the cubic feet of wood in the
bole of the tree, and then proceed from there with the Jenkins system. TallTimber is flexible,
allowing you the choice of using either Scott’s equation or TallTimber’s to calculate cubic
feet, “seeding” the process. The results differ only slightly, but there is already an existing use
of Scott’s equation by those computing carbon values with FIA, so TallTimber provides utility
for those professionals already using Scott’s in an established process (see Figure 17).
The carbon reporting process uses a tree components approach. In other words, each tallied
tree in your dataset is broken into its constituent parts (roots, stump, bole, tops & limbs) and
the carbon is estimated in metric tons (or tonnes) for each of those components. A metric
ton equals 2204.62 pounds, and is the international standard in forest carbon reporting. The
acronym “AG” shown in the report means “Above Ground” while” AG CO2eq” means “Above

Figure 17. Individual Report Mode in TallTimber 4.0 provides tabs for Carbon Per Acre and Total
Carbon. Reports are based on Scott’s equation or TallTimber’s cubic foot calculation, which by default
is Smalian’s, but could be modified to Huber’s or Newton’s in Step 2.
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Ground CO2 equivalents”. Using C02 equivalents simply allows both the implied atmospheric
effect of sequestered carbon to be reported as well as the standard by which the globalwarming-potential of other greenhouse gasses can be compared. One unit of carbon has the
ability to impact approximately 3.67 units of atmospheric CO2.
The TallTimber reporting process is one that brings traditional forestry measures such as
basal area, trees per acre, and merchantable cords alongside estimates of carbon language
shown in Figures 18-19. We’ve done this to help forestry professionals more easily think
about carbon values. For example, metric tons of above-ground carbon tend to compare
similarly to merchantable cords of timber. While they are not always as close as shown in
Figures 18-19, it is not unusual for them to be quite similar. We encourage TallTimber users
to make these comparisons as they work with carbon reporting. Stumps contribute the least
carbon mass compared to other components of the tree shown in Figure 18.

Figure 18. TallTimber reports carbon by tree component, summed into above-ground carbon, and
finally as AG CO2eq. Merchantable cords, BA, and TPA are also included.
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Internally, TallTimber performs the carbon calculations in a stepwise approach, moving from
cubic feet of bole material, to volume of components, to dry biomass of components, to
carbon in components, to above-ground carbon. Along this process, TallTimber builds tables
and stores them in the navigation pane for inspection by the more curious or serious-minded
analyst. Most people will not care to venture into these background tables, but we have
provided them for clarity, for equation proofing, and for curious minds.
Statistical reports produced from the carbon tabs follow the structure of the Per Acre and
Total Carbon output, with component estimates made with their confidence values, standard
error’s, and CV’s (coefficients of variation). The variability of AG Carbon/Acre, shown in
Figure 19, is nearly identical to the variability of Merchantable Cords/Acre, an anticipated
outcome. The reports have an asterisk item for the “Top” heading, reminding readers that
this component includes branches. Foliage is generally not included in estimates of AG
carbon, but is calculated by TallTimber and included in the previously mentioned tables.

Figure 19. An example of a carbon statistics report providing variability information on the estimated
carbon and merchantable cord values. The assumptions regarding the volume equation process and
cubic feet per cord are printed in a box above and to the right.
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Supersections, Assessment Areas and Common-Practice Levels
A better understanding of TallTimber’s carbon reporting potential can be built on a few more
pieces of information relating to how different forest properties in the country can be ranked
or assessed with regards to their carbon offset potential. In other words, forest acreage gets
classified into differing buckets by a set of standards that are already in place. TallTimber has
some of these standards built in, making them easily accessible. The following describes in
general terms how the most common classification system currently works.
California’s Environmental Protection Agency has a department called the Air Resources
Board (ARB). The ARB is involved with standards and protocols related to carbon offset
projects done under California’s regulated compliance market. ARB protocols are used in
forest carbon offset projects outside of California as well. One of the basic elements to ARB’s
classing of forested land is based on a generalized map of similar biophysical land conditions,
shown below in Figure 20. Each of the colored regions in Figure 20 is called a “Supersection”
and is the first division of forested land within the ARB’s classing system. TallTimber has this

Figure 20. U.S. Supersections mapped by California’s Air Resources Board. Supersections are an early
level of classifying forested land, and can cross state boundaries. The above map is accessible from
TallTimber’s main switchboard “Codes” button.
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map embedded in it and can be viewed by starting from the main switchboard and selecting:
Codes > Calif. EPA ARB Supersection Map.
Within each Supersection is a secondary division of forest land called an Assessment Area.
Assessment Areas can be thought of as a very broad collection of forest types that are
irrespective of stand age or development class (e.g. “Cove Forests”). There are generally
between 3-6 Assessment Areas for each of the 97 Supersections, creating a current total of
322 Assessment Areas. Lastly, because some of the Assessment Areas are further subdivided
by site productivity classes, such as “Cove Forests/Site Class 1-4” and “Cove Forests/Site Class
5-7”, we calculate a total of 432 Assessment Area strata currently in the lower 48 states.
Importantly, the stocking levels for each of these Assessment Areas are calculated from a 5year panel of USFS FIA plots with the mean stocking levels for these different strata getting
benchmarked as “Common-Practice Levels” (CP’s). These CP levels are by basal area/acre,
board feet/acre, and tons/tonnes carbon per acre stocking. TallTimber 4.0 has this CP level
information at the ready and allows you to print out any State’s CP information along with
your other reports by using Combined Report Mode (Figure 21). Corresponding to the USFS’s
FIA process, board feet/acre values are in units of International ¼” Log Rule.
The CP levels rely on FIA data, with some of them also relying on FIA’s site productivity class
code (SITECLCD) variable as a further distinguishing metric (stated above). Information on this
variable can be accessed by starting from the main switchboard and selecting: Codes > CPLevel Site Class Codes. The site productivity class code values go from 1 to 7 and are
calibrated in units of expected cubic foot growth/acre/year. You might reference this
information if your project includes classifying forest land into correct Assessment Areas.
To make the most use of the Common-Practice level information provided by TallTimber, you
will need to figure out which Supersection your property lies within, and then do your best
job of assigning your inventory strata to the appropriate Assessment Areas. While some
TallTimber users don’t need to work with carbon at this time, others that want to work with
carbon will still have different needs. Some people will just want to make a general
comparison of the property in question to Common-Practice levels, while others will have a
bigger process.
A bigger process may involve multiple Supersections and several dozen or more Assessment
Areas. These projects might benefit by stratifying the input data by Supersection x
Assessment Area under the TYPE variable so that you can directly compare your forest to
Common-Practice levels in the appropriate Supersection. In either case, TallTimber allows
you to check out how the property in question measures up to public benchmarks.
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Figure 21. Common Practice levels by Supersection and Assessment Area for a hypothetical forest in
Massachusetts. Massachusetts has 2 Supersections and 13 Assessment Areas.
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Working with TallTimber: Step 5. Growing the Inventory, Including Growth Reports
(Videos 10-12 on Playlist)
One of TallTimber’s most helpful features is that it simplifies the creation of input files and
facilitates the use of the US Forest Service’s FVS growth model (Forest Vegetation Simulator),
and its Suppose interface. If you have no experience with FVS, skip to the Appendix and read
A Digression on FVS.

Figure 17. The growth process begins by clicking Step 5, followed by clicking the first button on the
TallTimber 2 FVS form. This opens the larger FVS Input form, shown above with the FVS Variant choice
being made.
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Along with easier FVS input file production, TallTimber creates helpful reports that calibrate
FVS cubic foot volume output to TallTimber produced volumes. In this way, operators get
growth projections that are calibrated to the inventory they have just collected, which may
be different than the regional average information relied upon if using uncalibrated FVS
output. Operators can produce growth projection reports that can be added as a last page of
the inventory report, or just the input files required for starting a larger growth modeling
exercise. Either way, TallTimber accommodates the required inputs for growth modeling an
inventory.
After clicking the Growth button (Step 5) on the Start form, the TallTimber 2 FVS process
starts with entering basic input data required by FVS. Operators click button 1 on the
TallTimber 2 FVS form shown in Figure 18 (next page). The first entry required on the FVS
Input form shown at the top of Figure 17(previous page) is the FVS Variant, the geographic
locale of the model growing their data.
After choosing the variant appropriate for their dataset, the next choice is how the individual
plots within a stand, type or stratum are to be aggregated with respect to the tree list input
file (*.fvs files). This is shown at the top of Figure 17 as Item “B. Combine Points at
Stand/Strata level?”, a required entry on the FVS Input form. This is a somewhat technical
issue to discuss, and most operators should just remember to always select the “Yes” button.
We touch on the technical side more in the next paragraph.
In most cases, you will want all points within a stand or stratum to be listed one after the
other in a single *.fvs file. For example, if you have 175 total cruise points over five stands or
strata, you would have just five *.fvs files, one named for each stand or stratum in the
inventory. When this is chosen, FVS averages plots within a stand/stratum equally and
produces summarized growth output of plot averages for that stand, type or stratum.
Occasionally, but not often, you may want to grow each point or plot independently, making
a tree list for each point or plot, and then growing them individually. This might be the case if
you needed to weight your points or plots differently within a stratum or type, meaning you
want to control the averaging process outside of FVS.
TallTimber accommodates this possibility, and allows you to choose “No” for item “B.
Combine Points at Stand/Strata Level?”. In that case, rather than name the *.fvs file after the
stratum containing it, TallTimber will name the *.fvs file after the point or plot number, as in
158.fvs (an FVS tree list file for an assumed point #158). Again, this is the exception, and is
only included for those growth modelers who have goals different than the typical TallTimber
operator. It’s also important to mention as those choosing this option will not be able to use
TallTimber’s growth reporting functionality without modification. However, operators making
this choice will likely want to build a stratification process that is specific to their unique
project, so we suspect this is a non-issue.
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Figure 18. The FVS Input form allows assigning (A) a model variant, (B) the tree data combination
choice, and (C) four variables determining site index, site index species, location of FVS input files, and
the year simulation starts. Clicking Return stores these values and closes the Input form.

Figure 18 shows the same FVS Input form from Figure 17, but now filled in for a hypothetical
forest and its timber cruise dataset from the Lake States region (variant = LS). We can see
that the dataset has four strata; H, HS, S, and SH and was hypothetically cruised in the winter
of 2017. By entering 2017, the growth modeling results will include the 2017 growing season,
rather than beginning with the 2018 growing season, which would be appropriate if the
cruise occurred in the fall of 2017 or the winter of 2018. Operators should be alert to this as it
relates to the cruise history of their datasets, making sure they don’t give or take a year of
growth from their output.
From Figure 18, we also see the site index and site index species assigned to the different
strata. Site index information is available through a multitude of online sources, including the
Forest Service’s FIA (Forest Inventory and Analysis) data and the Natural Resources
Conservation Service (NRCS). For our hypothetical forest, we buttressed our professional
experience with an NRCS paper on site index titled Michigan Forestry Conservation Technical
Note #23 (2003) and entered the values shown in Figure 18. Lastly, we filled in the text boxes
associated with the “Input Files Locations” header with a path statement indicating putting
the files in a folder called “Scrap” that is located on the C drive (C:\Scrap\). This last part is
facilitated by an explorer window that opens when you click on the Input File Locations text
boxes. In that fashion, operators can easily navigate with their mouse to the folder where
they want the files written and click OK.
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Clicking Return on the FVS Input form stores those values and also checks to see that they
have been completely filled out. If not completely filled out, operators are warned of that
with a message box that pops us and gives them a choice of returning to complete the Input
Form, or close it with incomplete information.
Figure 19 shows the action of Step 2 on the TallTimber 2 FVS form, which simply opens the
FVS File Precheck report which gives operators an opportunity to make sure the FVS input
files will be created as intended. This is another “measure twice, cut once” step in TallTimber.
We want to make sure operators have selected the correct variant, that all the intended
strata have been appropriately filled in, and that the 0-tally points are once again accounted
for in the FVS input files soon to be created. While this is an optional step, it is suggested to
spend a minute looking over the Precheck report.

Figure 19. The second item on the TallTimber 2 FVS opens the FVS File Precheck report for operator
inspection of their input choices. For example, showing the FVS variant chosen.
ttimber.com

34

The third item on the TallTimber 2 FVS form opens the Build FVS Input Files form, a simple
form shown at the top of Figure 20. Clicking the three buttons on this form (Location, Stand,
Tree) writes the input files necessary for running FVS to the computer path prescribed earlier.
There are three types of files getting written and they are described below from most general
to most specific. There is a hierarchy to their structure, with most general (location) moving
towards most specific (tree). All three file types are required.

Figure 20. The Build FVS Input Files form executes the building of the FVS input files.

Three FVS File Types:
Location file: One per inventory, always named “Suppose.loc”. It lists the names of the
stands/strata and where on the computer their files reside.
Stand list file(s): One file for each stand/stratum to be grown, have “slf” file extensions. Has
site quality information and other stand level attributes.
Tree file(s): Typically one file for each stand/stratum to be grown, but can be as many as
there are points/plots. This depends on the aggregation choice made earlier. Has tree data.
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After building the input files, the next step is to launch Suppose, the interface operators
interact with to run the FVS growth model. If you do not have FVS Suppose installed, you will
need to do that before proceeding. FVS can be downloaded from the Forest Service website
and installed as a complete package
(https://www.fs.fed.us/fmsc/fvs/software/complete.php). For more information on growth
modeling with FVS Suppose, jump ahead in this manual to the Appendix section titled A
Digression on FVS.
Regarding FVS, our goal with this manual is to provide an overview of FVS function, and how
it integrates with TallTimber via the TallTimber 2 FVS process. Operators having had little
exposure to FVS modeling or are just starting their journey with computers can be best
served through direct instruction, which is why we’ve worked hard to provide a helpful video
resource at the TTimber YouTube channel (videos are listed towards the end of this
document). We recommend that all people, with limited FVS experience or not, check out
our instructional videos for better understanding how to use FVS and TallTimber generally.
Website addresses for FVS manuals and training are listed in the Appendix and our website.
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The top of Figure 21 shows the Suppose interface opened with the stand selection form
located on its right after the “H” stratum was selected (highlighted in blue) and added by
clicking the “Add 1 Stand” button. The stand selection form opened after the Locations file
(Suppose.loc) was opened through the File menu shown at the top left of Figure 21. The
process is one where operators grow each stand or stratum in a series of steps, which are
then repeated for the next stand or stratum (first H, then HS, etc.).

Figure 21. The Suppose interface is launched by clicking the button shown above on the TallTimber 2
FVS form. Next, the “File” menu is chosen and the “Select Locations File” option is used to open the
Suppose.loc file. Then the stand is added by working with the Select Simulation Stands form shown to
the above right.
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One of the required aspects to make the TallTimber 2 FVS work properly is that FVS needs to
send its growth projection output to a database called FVSOut.mdb. TallTimber links to this
FVSOut database to make its reports, and if the output is not there, the reports won’t be
available. This database was included with your TallTimber purchase, but really is just a blank
MS Access database named FVSOut.mdb. So, if you accidentally deleted it, or otherwise don’t
have this database, just create a blank database in the mdb format, making sure it is named
FVSOut and located within the same folder as TallTimber (C:\TallTimber\FDL). FVS does not
currently write to accdb style databases, so the mdb format is key.
While stressing that the FVSOut.mdb is required for successful report production within
TallTimber, we add that it is not necessary to simply run an FVS simulation. If it is absent, or
not properly linked to TallTimber, FVS will just run and the output won’t arrive at the proper
location. This ability to send output to the FVSOut database requires what is called an ODBC
connection, a link that allows the FVS model to open FVSOut.mdb and create tables of
information in the FVSOut database, a “container” of sorts for database objects. Setting up
an ODBC connection is something you only need to do once for FVSOut, and the process is
well described in this 2016 Forest Service document
(https://www.fs.fed.us/fmsc/ftp/fvs/docs/gtr/DBSUserGuide.pdf), and generally shown in
Figure 22 (next page) for a 32-bit MS Office installation and 32-bit FVS (the most common
version) on a Windows 8 operating system.
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If you look closely at the background of Figure 22, you can observe the slightly shaded
selections made to start the ODBC process. First, start by navigating to the Control Panel,
then to Administrative Tools folder under System and Security, then double click on the ODBC
Data Sources (32-bit) file which will open a form titled ODBC Data Source Administrator.
Within the ODBC Data Source Administrator form, choose the second tab, System DSN (NOT
User DSN). Clicking the Add button will open the form shown in the center of Figure 22 titled
Create New Data Source. On that form, select the Microsoft Access (*.mdb) option, shown
highlighted in blue in Figure 22, then click Finish. Now click Add on form ODBC Data Source
Administrator (32-bit).
Clicking Add opens the ODBC Microsoft Access Setup form shown in Figure 23. Enter FVSOut
in the blank text box titled Data Source Name, and click the Select button, which opens the
Select Database form shown in Figure 23 (next page). Use the Select Database form to
navigate to the FVSOut.mdb database, which must be located in the C:\TallTimber\FDL folder
as shown below in Figure 23. After selecting FVSOut.mdb, click OK on the next three forms,
closing up this process and finishing the creation of the Data Source Name and the ODBC
connection. The three forms are shown one on top of the other in Figure 23. We

Figure 22. The first steps in creating an ODBC connection and DSN for FVSOut.mdb start in the control
panel.
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repeat that if done correctly, and the FVSOut.mdb database is not moved or renamed, you
will not have to repeat this process again. The DSN made (FVSOut) is a durable item that
exists after you close FVS and shut the computer off.
TallTimber is set up to look for the FVSOut.mdb database in the specific location stated in this
manual. Lastly, we add the fact that data source names (DSNs) also work with MS Excel and
other types of database file, we use MS Access as it’s the most common. It’s possible to

Figure 23. After entering “FVSOut” in the text box above as a Data Source Name (DSN), clicking the
Select button allows us to navigate to the FVSOut.mdb database located at C:\TallTimber\FDL.
Clicking OK is then followed by clicking OK on the ODBC Microsoft Access Setup form, establishing the
ODBC connection.
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Figure 24. Clicking the Add Keywords button opens the Use FVS Keywords form. Two keywords need
to be added in the TallTimber 2 FVS process, DSNOut and Summary. Both of these keywords are
found in the Database Extension pane, highlighted above in blue.
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customize TallTimber to look for an Excel spreadsheet DSN rather than FVSOut.mdb, but that
is not the standard formulation we are describing in this section.
Having successfully created the DSN, we move back to the Suppose interface and continue
the growth modeling started earlier. We selected “H” as the first stand or stratum we are
going to model as shown in Figure 21 and also in Figure 24 on the left side of the Main
Suppose simulation window pane, where the words "Stand: H" appear. Operators must then
select the Database Extension (in blue) in Figure 24 to add Keywords.
To get the output we need, FVS requires us to enter several “keywords” in the assembly of
the growth formulation we started earlier. These keywords are easily entered through the
Suppose interface, by using the mouse navigation to the keyword form as shown on the right
of Figure 24, and double clicking DSNOut. After double clicking DSNOut in the keyword pane,
a form titled Database Extension DSNOut opens. Operators need to enter the name with path
location of the FVSOut database, just as shown in Figure 24 (enter this:
C:\TallTimber\FDL\FVSOut.mdb). After closing that form, next scroll down the keywords pane
and double click the keyword Summary, which instructs FVS to create a summary table of its
growth output, sending it to FVSOut.mdb. The addition of the Summary keyword is shown in
Figure 25, with Figure 26 showing how both DSNOut and Summary have been successfully
added as keywords.

Figure 25. Operators add the Summary keyword by double-clicking it, highlighted in blue above. Then
choosing ok adds it to the simulation pane.
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Figure 26. The Suppose interface shows stand/stratum H will be simulated with DSNOut and Summary
keywords through the database extension. This can be seen under the red font (Group: All)
statement.

ttimber.com

43

The last setting is to adjust the time scale by clicking the Set Time Scale button as shown in
Figure 26 and then Figure 27. Figure 27 shows the Set Time Scale form with parameters set
for a 30-year projection starting in 2017 with a five-year reporting interval. The 2017 matches
what we had chosen earlier when we filled in the simulation start year on the TallTimber 2
FVS form. We draw your attention to these numbers as FVS Suppose defaults to ten-year
periods and 100-year projections, which may or may not be acceptable. Some operators will
want tighter reporting intervals and a shorter projection length. This needs to be reset after
each run, if changed from the FVS default. You are ready to click the Run Simulation button.

Figure 27. Setting the time scale involves setting the period length (cycle length) and the ending year.
The starting year should already match the choice made earlier when entering growth parameters in
TallTimber.
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Step 5 is the more complicated part of TallTimber, and takes a few practice runs for most
people to smoothly accomplish. At this point we have taken the below steps, finalized by the
clicking of the Run Simulation button, which should launch a DOS window where FVS will
briefly run. We list the steps to help focus you on what we've done after clicking the Step 5
button to get to this point.
1. Input stand parameters such as site index, site index species, year to start simulation, and
regional variant.
2. Checked our stand parameters to make sure we have made the correct choices.
3. Create location file (Suppose.loc), stand files (*.slf), and tree files (*.fvs).
4. Launch FVS Suppose.
5. Choose File menu and open the locations file (Suppose.loc) from the folder where it was
created in 3.
6. Add the stand by clicking the stand name in the Select Simulation Stands form and Add 1
Stand button.
7. Establish DSN with ODBC Manager through Control Panel (this done just once, first use
only, not required for each use of TallTimber).
8. Add keyword DSNOut, and designate the database as C:\TallTimber\FDL\FVSOut.mdb.
9. Add keyword Summary. Both keywords should be visible in the pane under Simulation File
Contents:.
10. Set the timing of the simulation by opening Set Time Scale form and modifying it
appropriately.
11. Click the Run Simulation button on the upper right hand corner of the Main suppose
form.
At this point, we leave FVS Suppose open, and switch back to the TallTimber interface. If we
have a successful DSN connection, we should be able to view the growth projection by
clicking on the View Type Report button, which is shown in Figure 28. This growth report is
for individual stands or strata, with the H stratum shown in the diagram. The Summary
growth report creates a stratified growth report for all stands grown.
An important reminder for growth modeling is that TallTimber erases growth output each
time the Launch FVS Suppose button is executed. The implication of this fact is that you
should keep FVS Suppose open while modeling a given dataset. If you inadvertently close FVS
Suppose before finished modeling and don’t want to lose the projections made thus far, just
re-launch FVS Suppose from the desktop or the File Explorer rather than from within
TallTimber. TallTimber is set up this way to reduce the possibility of contaminating or
combining old and new inventory projections leading to invalid results. This is important to
remember and is a safeguard for clean FVS output.
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Figure 28. Clicking the View Type Report button builds the stand or strata growth report. The View
Summary Report button builds the stratified report, combining grown stands or strata to an average
weighted by acres.
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Operators have several options regarding retrieving the growth projections from TallTimber.
The first would be to simply click the Print button when the report is shown like the one in
Figure 28, resulting in either or both of the reports being printed (stand level and stratified
property level). Operators can also return to Step 4 of the home menu and navigate to the
combined report builder as shown in Figure 16 (page 23). The Report Builder form, shown
below in Figure 29 (below), has the FVS reports included as options on the Stand and Stock
tab. Lastly, operators can simply enter a value in these boxes after growing the inventory and
include these individual reports into the final compiled version.
We think that adding a final section of growth projections to a static inventory thoughtfully
reminds clients that forests change, and also become an opportunity to consider if, where,
and when management may be appropriate at the stand or stratum level. Figure 29 has the
FVS reports listed as the fourth and fifth in a series of individual reports. We remind you
when looking at Figure 29 that there may be other reports included from entries on the
Charts or MBF, Cords, Tons tabs which are not visible in Figure 29.

Figure 29. The Report Builder form is shown with five individual sub-reports included on the Stand
and Stock tab. FVS reports are selected as 4 and 5. You can select up to fifteen sub-reports to be
combined in their master report, typically a shared paper or digital product.
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In summary, you will need to understand that the TallTimber 2 FVS component has a few
more moving parts than the four menu steps required for processing an inventory and
printing out reports. TallTimber requires the first four steps be completed before the growth
area can be successfully performed. During the FVS modeling and after, TallTimber reporting
requires two successful links. One between FVS and FVSOut.mdb, and the other between
TallTimber.mdb and FVSOut.mdb. This means that a DSN must be created to allow FVS to
write the necessary tables, and it lastly means that FVSOut.mdb must be located in the
correct folder where TallTimber is looking for it (C:\TallTimber\FDL\). Most importantly, call
or email us if you are struggling in the TallTimber 2 FVS module, we'll help!
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Appendix A: More on FVS
For new FVS operators, FVS is a national tree growth projection and ecosystem modeling
platform, which has over 20 geographic variants suited for particular forest regions around
the United States. The four geographic variants directly coded into the FVS Variants combo
box (the dropdown list shown in Figure 18) cover the United States east of the Great Plains.
Each of the FVS model variants has its own published 80-100 page overview guide that can be
found on the FVS part of the Forest Service’s website. They are listed below, along with the
states covered by each variant. A broader publication intended for all operators is Essential
FVS: A User’s Guide to the Forest Vegetation Simulator (Dixon, 2017). It can be downloaded
at: https://www.fs.fed.us/fmsc/ftp/fvs/docs/gtr/EssentialFVS.pdf .
CN = Central States; IA, IL, IN, KS, MO, NE, SD
(https://www.fs.fed.us/fmsc/ftp/fvs/docs/overviews/FVScs_Overview.pdf)
LS = Lake States; MI, MN, WI (parts of eastern ND and northeast SD)
(https://www.fs.fed.us/fmsc/ftp/fvs/docs/overviews/FVSls_Overview.pdf)
NE = Northeast; CT, DE, MA, MD, ME, NH, NJ, NY, OH, PA, RI, VT, WV
(https://www.fs.fed.us/fmsc/ftp/fvs/docs/overviews/FVSne_Overview.pdf)
SN = Southern; AL, AR, FL, GA, KY, LA, OK, MS, NC, SC, TN, TX, VA
(https://www.fs.fed.us/fmsc/ftp/fvs/docs/overviews/FVSsn_Overview.pdf)
The FVS modeling platform is extensive, including numerous optional extensions and menus
of choices facilitating modeling of fire, insect outbreaks, and other ecosystem events best
tested via computer simulation. However, our goals with TallTimber are more basic. We
strive to make FVS accessible to foresters and landowners that are focused on simply growing
the inventory they have just processed. These people may not have done much growth
modeling, or don’t have time to dedicate the many hours required to become an FVS expert.
TallTimber does not make using FVS easy, but it does make it much easier. As stated earlier, a
major plus to using the TallTimber 2 FVS process is that it overcomes the FVS problem of poor
volume estimate calibration to local standards. TallTimber will use the merchantability
specifications you established in the inventory processing rather than those internal to FVS.
A smaller group of TallTimber operators may be interested in deeper growth and yield
studies, climate where more of FVS’s keywords are employed and silviculture is modeled. In
this case, we need to state that TallTimber’s current input structure allows the basic FVS
choices to be made. It is not setup to simplify all of the input options such as adding
increment core data to your tree input files (*.fvs files). It does include the tree history and
tree value class codes associated with the input data, based on the AGS/UGS or the product
section data originally input. It also is sure to bring the 0-tally points along to the growth
modeling input, as would be anticipated.
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In cases where more detailed projections are sought, TallTimber remains a very compelling
starting point for creating FVS input files from which independent growth analyses can be
pursued. In other words, create the input files with TallTimber followed by output processing
outside of TallTimber. We again suggest operators obtain the manual mentioned earlier
authored by Gary E. Dixon, Essential FVS: A User’s Guide to the Forest Vegetation Simulator
(https://www.fs.fed.us/fmsc/ftp/fvs/docs/gtr/EssentialFVS.pdf).
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Appendix B: TallTimber 4.0, Microsoft Access (MS-Access) and Its Free
Runtime Version
You don't have to know how to use MS-Access to use TallTimber. The User Interface (UI) built
into TallTimber lets you focus on your data, your specifications, and your output. Behind the
TallTimber UI, is a Microsoft Access database in a compiled format (mde or accde file
depending on what version of Access you are using). Most operators will just work with the
UI and will not need to open the tables or queries behind the TallTimber program. However,
we've kept many of these objects available for investigation for the more curious and
experienced. We distribute TallTimber in a fashion where it must be a purposeful effort to
explore the database side of TallTimber, as we don't expect most will want to view or be
bothered by the nuts and bolts of the application. Tables and queries are fully accessible, so
be warned that problems can arise if you edit or delete them inadvertently by exploring in
this area.
One helpful aspect of delivering TallTimber as an MS-Access file is that Microsoft offers a
free, run-time version of MS-Access for download from their website. People who are
interested in TallTimber, but don't currently have MS Access and don't want to buy the full
version, can download MS Access Runtime and use it as long as they want. MS Access
Runtime is a limited version of MS Access with no time limit on usage.
You will need to work with the bit version of TallTimber that matches your MS Office. The
main point to remember is that MS Office currently comes in two structures (32 and 64-bit),
and we provide TallTimber in both of these. Remember that MS Office means the programs
(Word, Excel, Access, Powerpoint, Outlook, etc.) while Windows is the operating system. A
64-bit Windows operating system often will have 32-bit MS Office installed, so don't guess
your MS Office architecture from your operating system. You only need to care about the MS
Office, whether it is 32-bit or 64-bit. You need to determine your setup so you can run the
correct instance of TallTimber. Figure 30 shows an example of the identification form found
under the File-Help command in a 32-bit, MS Access 2010 installation on a Windows 8
operating system. This might be found under the About command in other MS Office
configurations, but the best way to figure out your version is to go to the Microsoft website
and check: https://support.office.com/en-us/article/What-version-of-Office-am-I-using932788b8-a3ce-44bf-bb09-e334518b8b19. This link is also posted on our homepage.
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Figure 30. This image is from an MS Access 2010 version with 32-bit design. To view this image, we
selected the following menu options from within Access: FILE-->HELP. This information is also visible
in MS Word, Excel, and other MS Office applications. The discovery process varies, but may also be
found under ABOUT.

Download Site for Free Versions of MS Access Runtime:
MS Access Runtime: https://www.microsoft.com/en-us/download/details.aspx?id=10910
Regarding how the actual TallTimber file is named. We are using 32-bit format as the default
file format in the naming of the TallTimber.mde and .accde files. The TallTimber naming
convention, meaning that whenever there is a 64-bit program, we will add the "x64" to the
name. So, if you don't see the "x64" in the name, assume it is the 32-bit TallTimber.
Remember, TallTimber is a compiled program and the version you run must match your
version of MS Access (32-bit or 64-bit). The file names of TallTimber are shown below for
instances with 32-bit structure and also with 64-bit structure (x64). As stated elsewhere, we
distribute TallTimber as both mde and accde files for older and newer MS Access.
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Full Version (32-bit), file names: TallTimber_v40.mde, TallTimber_v40.accde
Full Version (64-bit), file names: TallTimberx64_v40.mde, TallTimberx64_v40.accde
You cannot run both 32 and 64-bit Office versions on the same operating system
simultaneously (as in 32-bit MS Word and 64-bit MS Access), that choice is made during the
initial installation for all MS Office products. We distribute TallTimber in both formats to all
customers, and if you choose the wrong version you will simply get a pop-up window giving
you feedback that you need the other bit format. Try the other version of TallTimber and you
should have success. To restate, we provide all the combinations when we send your
distribution kit.
TallTimber will come on a flash drive (hardware dongle) ready to be set up on your computer.
It may be in a zip archive (a compressed folder) having 8-12 files in it, or just the 8-12
individual files on the flash drive. These 8-12 files need to be copied to your system. You may
need to update the links to the to the FVSOut.mdb companion file with the Linked Table
Manager located on Access’s external data tab, as the default location for TallTimber is in the
following path: C:\TallTimber\. In other words, TallTimber comes with links to the
FVSOut.mdb file expecting to find it at that path (a folder named “TallTimber” at the first
level of your C drive). If you want to store TallTimber elsewhere, just update the FVSOut
links. The extra files that accompany TallTimber are detailed below.

File Name
Read_Me.txt
DeerLake.xls
TallTimber.ico
TallTimber.dll
TallTimberx64.dll
FVSOut.mdb

Description
Help file for setting up TallTimber
Example file of input data
Image file that program uses for icons
Library file required
Library file required
FVS output destination database

Importance
Helpful, not required
Helpful, not required
Icon file, not required
Required
Required
Required

Table 31. TallTimber comes as a compiled MS Access file, in mde and accde versions. It also is
provided in both 32 and 64-bit formats. The mde version works on all Access versions, while the accde
file works on newer systems only. There are seven additional files, shown above, which vary in
importance. Several are critical while others are helpful but not. It is critical that the library files (dll's)
are located in the same folder as TallTimber for it to function and that the table links to two tables
located in the FVSOut.mdb.
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Appendix C: Instructional Video Help with TallTimber
YouTube Channel TTimber, organized in a Playlist at this link:
https://www.youtube.com/playlist?list=PLaZotM2nHrOQMpmN7A5qxPQ3hxTnXD5QJ
Video Number
1. Input Data Formats
2. Creating a Named Range
3. Step 1-2: Importing Data and Changing Species Codes
4. Step 2: Changing Weight of Wood, Sort Order in Reports
5. Step 2: Merchantability and Regeneration Settings
6. Step 2: Cubic Feet per Cord, Scaling, Volume Equations
7. Step 3: Profile Report
8. Step 4: Individual Report Mode, Grid Data
9. Step 4: Combined Report Mode
10. Step 5: FVS Set-Up
11. Step 5: FVS Execution
12. Step 5: FVS Report Interpretation and Inclusion
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Appendix D: Quick Start Guide
For those who like to jump in and figure things out with less assistance, we offer the
shorthand version of moving ahead with TallTimber. If you already have MS Access on your
computer, are not flustered by uncertainty, give the following a try.
1. Create the folder path on your C drive of C:\TallTimber\. Put all files in your TallTimber
package in the TallTimber folder. There will be 6-12 files, depending on version. Check out
the Read_Me.txt file. TallTimber will work in other folders, but this folder structure is the
default for the links established with 2 tables in the companion file FVSOut.mdb.
2A. If you have a paid for version of MS Access:
Change the "Default Database Folder" setting to "C:\TallTimber ", or wherever you plan to
locate TallTimber on your system. The “Default Database Folder” property is found by clicking
FILE>OPTIONS>GENERAL and then looking on the Options form for "Default Database
Folder". Do this with a blank database, or just by starting MS Access without a database
opened, not from within TallTimber.
2B. If you have MS Access Runtime:
You can’t do #2A. Instead copy TallTimber’s files into the MY Documents or Documents folder
and you are done. You will need to update your FVSOut.mdb table links, but not the “Default
Database Folder” shown in #2A.
3. Figure out if you have 32-bit or 64-bit MS Office and use that version of TallTimber (your
package has both 32-bit and 64-bit TallTimber). This "bit" info will be somewhere like
FILE>HELP (MS Access 2010) or FILE>ACCOUNT>INFO (MS Access 2013).
TallTimberx64_v40.mde and TallTimberx64_v40.accde are the 64-bit versions.
4. Open TallTimber by double clicking on the version and format matching your system.
Remember that the mde formatted TallTimber will work on all systems, the accde formatted
TallTimber will work on MS Access systems since 2010.
5. Step 1: Import Data. Choose the example input data file that came with TallTimber
(Deer_Lake.txt or Deer_Lake.xls). You should get either a "Successful Import" message or a
message declaring a problem with the import dataset. Data can be text or Excel.
6. Step 2: Enter Input Parameters. Enter your prism BAF or fixed-radius plot size. All other
parameters are optional, and are numbered 2 through 7 on the TallTimber Inputs form.
Experiment with these later on, you can save your changes with "Keep My Codes".
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7. Step 3: Check Input Success. Verify that your input matches your understanding of the
data. Is this the correct number of points, is BAF or plot size correct, is the acreage correct?
8. Step 4: Process, Get Results. View/print output in any of three log rules, and either as
single reports or multiple compiled reports (74 prepared reports are offered) with a
professionally customized cover page. Copy/paste or export grid tables to Excel for further
analysis and reporting. This “Process, Get Results” step is a prerequisite to the TallTimber 2
FVS growth module.
9. Step 5: Growth. Brings you to TallTimber 2 FVS, a growth module allowing you to choose
an FVS variant and other stand level parameters, create input files, and grow your inventory.
TallTimber then links to the FVS output and provides detailed growth reports from the
multiple report interface as in Step 4 (above Item 8). You likely will need to go back in this
manual and read about Step 5 or watch our videos for those without FVS experience. See our
YouTube channel (TTimber) for direct video instruction and a more granular breakdown. You
can do this, the videos can help!
When importing raw data from an Excel file, be aware that TallTimber requires the data be
in a named range (an Excel term) called "Data". Alternatively, the input file can be in a
comma-delimited text file as is exported by Timberpad Pro. For an example of the Excel
dataset style, see the example data included with your TallTimber package. Remember to
include the top row (has heading names) in that named range. See the Timberpad Pro
supplemental manual for more information about text file input datasets.

ttimber.com

56

Appendix E: Species Codes and Default Values
TallTimber
1
Code
2
Code
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
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Species Name
White pine
Hemlock
Red spruce
Balsam fir
Red pine
White cedar
Sugar maple
Red maple
Paper birch
Yellow birch
Beech
Red oak
White oak
White ash
Aspen
Black cherry
Basswood
Tamarack
Other hardwd
Other softwd
Black birch
Black gum
Black locust
Black oak
Black walnut
Chestnut oak
Cucumbertree
Hickory(s)
Norway Spruce
Pine(s)
Sassafras
Scarlet oak
Sycamore
Yellow poplar
Snags
Black ash
Black spruce
White spruce
Butternut
Elm
Balsam poplar
Hophornbeam
Shagbark hickory
Pignut hickory

FIA
129
261
97
12
125
241
318
316
375
371
531
833
802
541
746
762
951
71
2
999
373
693
901
837
602
832
651
400
91
100
931
806
731
621
543
95
94
601
972
741
701
407
403

Girard FC FVS Spp Code
0.8
WP
0.78
EH
0.8
RS
0.8
BF
0.8
RN
0.76
WC
0.79
SM
0.79
RM
0.78
PB
0.78
YB
0.84
AB
0.78
RO
0.78
WO
0.8
WA
0.78
QA
0.8
BC
0.8
BW
0.8
TA
0.78
OH
0.78
OS
0.78
BB
0.78
BG
0.78
BL
0.78
BO
0.78
WN
0.78
CO
0.78
CU
0.78
HI
0.8
NS
0.8
PI
0.78
SS
0.78
SO
0.78
SY
0.78
LP
0.78
0.78
BA
0.8
BS
0.8
WS
0.78
BN
0.78
AE
0.78
BP
0.78
HH
0.78
SH
0.78
PH

Lbs/Cu. Ft.
50.59
56.47
49.41
49.41
50.59
40
63.53
52.94
52.94
63.53
52.94
63.53
63.53
52.94
50.59
52.94
50.59
56.47
63.53
49.41
63.53
52.94
65.88
63.53
52.94
63.53
52.94
65.88
49.41
50.59
52.94
63.53
52.94
56.47
54.12
52.94
49.41
49.41
50.59
52.94
50.59
65.88
65.88
65.88
57

TallTimber
45
Code
46
Code
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
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Species Name
Shell. hickory
Mocker. hickory
Sweetgum
Silver maple
Cherrybark oak
Live oak
Bur oak
Overcup oak
Water oak
So. red oak
Cottonwood
Baldcypress
Loblolly
Slash pine
Longleaf pine
Shortleaf pine
Jack pine
E. Redcedar

FIA
405
409
611
317
813
838
823
822
827
812
742
221
131
111
121
110
105
68

Girard FC FVS Spp Code
0.78
SL
0.78
MH
0.78
SU
0.79
SV
0.78
CB
0.78
LO
0.78
BR
0.78
OV
0.78
WK
0.78
SK
0.78
EC
0.78
BY
0.78
LP
0.78
SL
0.78
LO
0.78
SH
0.78
JP
0.78
RC

Lbs/Cu. Ft.
65.88
65.88
52.94
52.94
65.88
50.59
75.80
63.53
63.53
63.53
50.59
56.47
58.00
60.00
60.00
58.00
56.47
45.00
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Guide to Timberpad Pro 2.5 Data Collection Software

About this Document
This document is intended to get you going with Timberpad Pro. Different people learn
differently. Some are very tactile or "hands on" while others learn faster by reading and
thinking. This document does not address every nuance of using Timberpad Pro, it is more of
a pictorial to get you going with pictures and some details. You will need to interact with it on
your device ultimately, but reading and thinking about it first is a great approach. Readers
interested in runtime licenses and platform (iOS & Android) information can go to page 76.
Explaining Timberpad Pro is made slightly more complicated as it is cross platform and can be
used on a variety of devices. The 2.5 version being released with this manual (April, 2021) has
been developed for iOS (Apple mobile) and Android. However, we also developed a version
for the older Windows Mobile 5 system as we have used it extensively ourselves on those
older devices and wanted to accommodate 1)foresters trying to stretch out their hardware
investment dollar, and 2)those cruising in the harshest conditions where small screens and
physical buttons are required. The versions operate similarly, with the iOS and Android
versions being smoother-faster outside those severe conditions of deepest cold or heavy
rains.
With that said, this manual mixes images of the iOS (lighter images) and Android (darker
images) platforms. The iOS and Android versions function almost identically, and screenshots
from both devices are included so more readers can view here what to expect on their
devices. Your device may provide a slightly different look than what is shown here. If and
when questions arise, don't hesitate to contact us. Here are some forms of Timberpad Pro
Technical Support:
1. Operator's manual (this document)
2. Instructional videos playlist on YouTube channel (TTimber channel)
3. Website: www.ttimber.com has an overview video of Timberpad Pro iOS.
4. Email us: support@ttimber.com
5. Call us: 207.377.3956 or schedule a visit or a workshop for you or your group
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What is Timberpad Pro?
Timberpad Pro (or TPad for short) is data collection software designed for forest inventory,
commonly called timber cruising. We have used earlier versions for over 10 years. Figure 1
depicts TPad's role at the start of the inventory process. We have tested TPad on a variety of
devices running the Android operating system from Honeycomb to Nougat, iOS devices from
iPhone 5 and original iPad forward. Timberpad Pro 2.5 has not been styled for the largest
iPad, the much larger iPad Pro.
TPad Android functions as a small collection of files on your device while TPad iOS functions
as a single FileMaker Go file. TPad provides several tools to export data from its database
table into files that can be imported into spreadsheets and databases. This export is most
easily done via email, but can be a cabled copy/paste of the file (iCloud AirDrop, too). Other
helpful tools such as a limiting distance calculator and product specification
importer/exporter are also part of TPad, and are shown later in this manual, along with
version and runtime license information described near the end of the document. Flip to the
final pages of this document (p 77) for Quick-Start information if you're in a hurry.

Figure 1. Timber cruise data is logged into the tablet/phone/device with Timberpad Pro, which then
exports the raw data to comma delimited files that can be emailed or otherwise transferred to
spreadsheets and database programs such as TallTimber for processing.
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TPad itself does not create the suite of final outputs possible with TallTimber, such as robust
reports, spreadsheet tables or charts. It does provide a running tally of basal area per acre,
trees per acre, number of total points, number of 0-tally points, and number of tally trees.
Figure 2 shows the forms (Android) you interact with when using TPad. The main form itself is
a tabbed form with 3 tabs allowing you to shift between 3 neighboring forms; Setup, Tally,
and Tools (Tools shown below and on cover of this document). You spend most of your time
using the 3 tabs on the main form, with occasional jumps from the buttons shown below on
the Tools tab to other individual forms, the smaller images with the titles shown below.
Limiting Distance Form

Species Codes Form

Product Specs Form

Tab color contrasts
when selected

"Tools" Tab of Home Form (Android Platform)
Figure 2. The Timberpad Pro Home form (the bigger image above) has 3 tabs, with the Tools tab
shown above. Nine buttons are located on the Tools tab which perform functions supporting the basic
data entry of tallying trees (done on the Tally tab). The Setup tab, the most left tab, is where project
and plot level data is entered. The above images from an Android device.
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Stepping Through Timberpad Pro's 3 Tabs
Rules for File Naming of Your Data Table During Export and Import
iOS: Value of Project Name in the first tree record is appended to "TPad_" to
make the file name: TPad_MyWoodlot.txt (Cruiser is not used with iOS)
Android: Values of Project Name and Cruiser fields in the first tree record
are combined to make the file name: MyWoodlot_JDP.txt

iOS has an
EXIT button.
Android uses
device's close
button.

iOS

Android
"Setup" Tab of Timberpad Pro Home Form

Figure 3. Project and plot summary data is entered on the Setup tab. Values entered in the Project
Name, Cruiser, Stand/Strata and Acres fields for the first record are automatically copied forward for
each new record. Changing the Stand/Strata and Acres values when working on a different
stand/strata has the new values copied forward. As shown above, Timberpad Pro uses different
naming conventions for exporting and importing files depending on whether iOS or Android, but is
consistent on using the first record for this information.

New plots can be added via the autoplot system that increments plot numbers by 1 for each
new plot, a manual system that allows cruisers to enter their own integers (pages 64, 71), or
by importing a dataset. Plot location is collected when adding a plot via the Plot+GPS button.
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Tally Tab
The TD+ button (Tree Duplicator) allows you to add a tree record with the same species as
previously entered, saving time on the species code entry for that tree. This is quite helpful
where trees of the same species are "clumped" or just follow each other in the tally on a
given plot. The iOS format allows (shown with checkbox settings) duplication on diameter
and product as well as just species. This is handled with via a popover button.
The Top field is for entering the diameter inside bark (DIB) of the tree at the limit of
merchantability. Top can be set to 0 if cruisers don't wish to call a Top DIB. We can set the
default value of Top for whatever fits your process and region at purchase time. Top value
standards vary by region and pulpwood markets.

iOS

Android

Figure 4. The Tally tab is where you collect data on individual trees, and actually spend most of your
data entry time. Species codes can be entered as either alpha or numeric codes. The grid control
(looks like a table) allows scrolling and jumping to individual records with touch screen devices. With
Android, touch the bright red buttons for entering DBH and Multi-Product values. If cruising in SawPulp height mode, enter the merchantable height in feet of sawlog material in the "Saw Ht" box and
then the height of any pulpwood or topwood above that in the "Pulp Ht" box (Android shown).
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Tools Tab

UPPER ZONE: 9 BUTTONS THAT
JUMP YOU TO A NEW FORM,
CHECK DATA, OR PERFORM AN
IMPORT/EXPORT TASK.

iOS

LOWER ZONE: Entering a BAF
and then clicking the yellow
“Click!” button provides
running estimates of the
cruise.

Figure 5. The Tools tab has 2 zones. The upper zone provides useful tools related to collecting, saving,
and emailing data. An email client must be set up on the device for the auto-email to function (gmail
works fine). The TT Format button produces TallTimber ready datasets.

The Tools tab is functionally divided into upper and lower zones. The upper zone has 9
buttons that are linked to useful tools as shown in Figure 5. We cover 8 of the 9 buttons on
pages 67-74. The 9th button is labeled "About", and has license and contact information.
The lower zone provides basic information on the current dataset for variable radius
sampling. Enter the cruise BAF and press the yellow Click! button to populate the 2nd zone
with up to date information. Pop up messages occur alerting cruisers to any null or 0 DBH
values that might impact the TPA estimate. The basal area and TPA estimates are rounded
down and presented as integer values.
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Limiting Distance Calculator
Limiting Distance Ghost Message
(Android Device)
Figure 6. Horizontal limiting distances are addressed three ways in TPad. The limiting distance
calculator itself, the optional ghost messaging (Android), and the HLD button on the Tally tab.

First is the Limiting Distance Calculator itself, shown above. This is an easy to use tool that
you jump to from the Tools tab. It accommodates slope % values, alleviating the need for
slope correction factor tables. The DBH value in the tool is automatically populated with the
DBH of the last entered tree and in turn populates the BAF value shown in Figure 5 on the
previous page. It provides 6 prism BAF choices.
The second method, shown to the right, is a time saving convenience we call ghost
messaging, and is for Android devices only. After DBH is entered and any next screen tap
occurs, TPad will display a 5-10 second temporary message stating the horizontal limiting
distance (HLD) for the tree. The program relies on the BAF and Slope % settings last
established in the Limiting Distance Calculator (show above as BAF 15 with 25% slope). This
ghost messaging provides students, cruisers changing to a new prism BAF, and the less
experienced consistent feedback and eye calibration on when to check for borderline trees. It
can be turned off with the Warnings Checkbox. The third way limiting distances are produced
is by simply tapping the HLD button adjacent to DBH (works for iOS and Android). This
presents a message box stating the limiting distance for the current DBH, BAF, and slope.
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Species Codes Form Shown After Selecting the "Spp Codes" Button
Figure 7. Timberpad Pro allows you to enter your own species codes, and TallTimber allows you to
map in your own 1 or 2 character alpha-numeric codes. While a drop down menu of numeric codes is
provided on the Species dropdown, we can modify your species dropdown at your direction. The
above codes are a lookup guide for people wanting to use the TallTimber alpha codes. Numeric codes
have become somewhat standard in the Northeast and are the defaults, subject to modification.
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This is a scrollable screen, allowing you to save
specifications and share them with your team or
store in the cloud. Scrolling down allows entry
of information on all 7 multiproduct codes.

Product Specifications Form (Android Platform)

Figure 8. The Products form is most helpful for managers and those leading larger projects where
teams of cruisers need to have consistent specs stored in a handy spot. The Products tool allows the
writing and sharing of record specifications for the 7 product codes used in the Multi-Product system.
There are 5 lines for the sawlog product (code 2) and 2 lines for all other products (sawlog products
often have more detailed specs). Managers can export their file specifications and share with other
cruisers for importing on to their device or store for future reference. Each of the above lines is
scrollable to the right, creating adequate space for specifications. As mentioned at the top of the
page, the form itself is scrollable up and down. Those not using Multi-Product mode can also readily
use this tool for storing and sharing their product specifications, or simply as a note area.
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After Export/Email

Before Export/Email

(iOS Platform)
Figure 9. Export Tool Dialogues: Exporting the entire TPad data table to text or csv file. As mentioned
on page 64, the export function uses input field values from the first record for the file name, such as
“MYWoodlot” in the above example, where the saved files are TPad_MyWoodlot.txt and
TPad_MyWoodlot.csv. You also have the option of emailing your dataset if an email software client
has been established on your device or just saving it to your iPad or iPhone for later transfer.
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2. Append or start fresh?

3. Successful import

1. Before Importing

(Android Platform)
Figure 10. Import Tool: Importing a TPad data table from a comma-delimited text file. The import
function uses information in the FIRST RECORD to search for the file name. If no dataset exists on the
device, you add a single new record and enter the proper values (see Figure 3, page 64) to match the
dataset you wish to import. The Import process provides the option of appending to the existing
dataset or total replacement with the imported file.
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(Android Platform)
Figure 11. Delete Tool: Clicking this button launches a 2-step delete operation that will eliminate all
tree records in TPad. You get 2 warnings to avoid accidental deletions. This function can also be
accessed through the "hamburger" button (3 lines) on your device, if it has one. This does not
eliminate log specifications or limiting distance settings stored on their respective tool forms.
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Results of Checker (with errors)

First Message

(Android Platform)
Figure 12. Null Checker Tool: The checker tool looks for 0's and Null values in all of the 9 variables
necessary to create a TallTImber input dataset. It does not check the other variables that may be
collected, and is a helpful step in getting a sound dataset. The dataset used for this diagram was
missing 2 diameter values and 2 species values, which can be seen in the "Results of Checker" box.
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Before Export/Email

After Export/Email

(iOS Platform)
Figure 13. TT Format Tool: This exports a data file with the 9 variables required by TallTimber, making
a TallTimber ready input file with correct headings and variables. The filename is based on the Project
Name on the Setup Tab, shown above as "MyWoodlot". This produces a file named
"TTdata_MyWoodlot.txt" as stated in the popup message. An overwrite warning message appears if
you attempt to export a file with the same name as an existing file on their device. You are given a
choice of emailing this file or just writing it to the device.
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iOS

Android

Manual Plot Numbering Activated by a Checkbox
Figure 14. Timberpad Pro's default is an automatic plot numbering system which automatically
increments (+ 1) to the largest plot number whenever the "Plot+" or "Plot+GPS" buttons are clicked.
Manual plot numbering is turned on by selecting the checkbox in either the popover button (iOS) or
the checkbox near the Plot+GPS button (Android). Plot numbers must be integer values.

The "Plot+" and "Plot+GPS" buttons are how you typically add a new plot to your dataset,
and they do this as tree 1 for the new plot (plot 1 tree 1, plot 2 tree 1, plot 3, tree 1, etc.).
At times, however, you may want to assign a different plot number than the naturally
incremented + 1 method, we call this manual plot numbering. As described below, the
manual plot numbering process differs somewhat between the two Timberpad Pro platforms.
In either case, cruisers need to pay attention that they don't enter a plot number that already
exists in their dataset when using the manual numbering option.
iOS: Timberpad Pro iOS uses a popover button checkbox (shown above in iOS image) that,
when checked, will cause the Plot+ buttons to open a keyboard for your manual plot number
entry.
Android: By selecting a checkbox near the "Plot+GPS" button (shown), Timberpad Android
reveals an edit box on the Tally tab where the cruiser then enters the plot number. After
typing in the new plot number, the cruiser goes to the Setup tab and clicks the "Plot+GPS"
button, creating the new plot. The edit box goes away when the checkbox is deselected.
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Versions of Timberpad Pro and Runtime Licenses
Timberpad Pro licenses are available for both Android and Apple's iOS platforms. Similar to
needing Microsoft Excel to create Excel spreadsheets, Timberpad Pro requires you to have its
runtime environments installed on your data collection device, too. The Android version of
TPad requires the installation of the runtime environment DroidDB while the iOS (Apple)
version requires FileMaker Go.
FileMaker Go is a free download from the AppStore, and easily installs on your tablet or
phone. DroidDB runtime is available for free in the trial version or as a purchased license for
$5 from the DroibDB website, or can be installed by us as part of your Timberpad Pro
purchase if we have access to your devices.
You can download and install those runtime programs or consult with us on getting them
installed. To be clear, the process is to install the runtime environment (either free or
purchased from the above sites) and then install Timberpad Pro. If you struggle with the
installation process we encourage you to call, email us for guidance, or consider letting us do
the installation by mailing us your device(s) or having them new devices shipped to us
directly, after which we would then ship to you.

Moving from Timberpad Pro to TallTimber
Information logged into Timberpad Pro can be transferred to your PC in a number of ways. To
get the data to your PC, you can use email/Gmail, Bluetooth, AirDrop, or for Android systems
by cabling to a desktop system and simply using a file browser to move your tree tally to your
home computer. In any event, the question then becomes how will we process this data,
turning it into information? We suggest TallTimber 4.0 as the best tool for doing just that.
The TT Format tool shown in Figure 13 is a fast way to get the data off your device for
processing via TallTimber. An example of the resultant text file output is shown in Figure 15.
TallTimber has import functionality that accommodates importing either a text file in this
format, or an Excel spreadsheet as shown earlier in this manual and on our YouTube Playlist
Video #1: Input Data Formats. Additional error checking occurs during the TallTimber import
process (Step 1 in TallTimber).
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Type,Acres,Plot,Spp,DBH,Product,AGS/UGS,Top,Reps,
"H3B",174,1,"HM",17.0,"1223555","",4,1,
"H3B",174,1,"WA",15.0,"22222555","",4,1,
"H3B",174,1,"YB",19.0,"523555","",4,1,
"H3B",174,1,"RM",8.0,"66555","",4,1,
"H3B",174,1,"RM",14.0,"5555555","",4,1,
"H3B",174,1,"WP",22.0,"222222555","",4,1,
"H3B",174,1,"WP",8.0,"777","",4,1,
"H3B",174,1,"BF",5.0,"66","A",4,1,

Figure 15. Above is an example of the TallTimber ready text file that is output by the TT Format tool
on the Tools tab. Species can be alpha or numeric, DBH can be integer or decimal, AGS/UGS can be
null as shown in all but the last record, which is an "A". This Point 1 had 8 trees.

Quick Start Comments and Tips
1. Data is entered into a single table for both Timberpad Pro formats. Timberpad Pro Android
has a folder named Data under the TPad folder. Android data file exports are made to this
folder located as follows (/DCIM/TPad/Data). Timberpad Pro iOS exports are easily viewed in
FileMaker Go by selecting the "Device" button at the bottom of FileMaker Go. This will show
all files as opposed to the "Recent" button that only shows a subset of files.
2. You create records one at a time by clicking either the Plot+ button to start a new plot with
its first tree (plot 1 tree 1, shows as 1-1 on the device) or the Tree+ button to add additional
tree records beyond tree 1. New plots are always the highest plot number + 1 if in autoplot
mode, or whatever integer you enter for a plot number while in manual plot mode.
3. New trees are added to the plots by clicking the Tree+ button. These will be added to the
plot you are currently in, and would start with Tree 2. For example, if you have one record in
your table, 1-1, adding a tree will add the record 1-2 (plot 1, tree 2). Trees are always
numbered the last tree number + 1.
4. Using the Tally tab's grid object, you can scroll through and jump around your entire data
table editing a tree or a plot quickly wherever necessary. Android jumping is done by pressing
on the record you wish to jump to, iOS has jump buttons on the right side of the table.
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5. It is highly recommended that you be sure to enter the Setup tab information to the first
record you create. This information will then be copied forward and you won't have to enter
it anymore, avoiding nulls and missing information to be filled in later. The first record info is
used when you export, so be thoughtful in your entries of Project Name, Stand/Strata, and
Cruiser for record 1. If you have a stratified sample and are adding different stands, you need
to update the stand information as you start collecting data for a new stand.
6. If you are trying to import a dataset and Timberpad returns an error message that the file
does not exist, try two things. First, make double sure the file exists on your device with the
proper name as shown in record 1 of your dataset. If your file does exist in the proper folder,
then the problem is likely that your device's registry needs to be refreshed. You can refresh
the device's awareness of the files by performing an export of some file, or turning it off and
on. We have had luck by exporting a Timberpad Pro table with the TT_Format button. Be sure
not to overwrite any important files and then delete the unnecessary file after the export and
retry the import.
7. Getting data out of Timberpad Pro is easily done by exporting a text file, using email,
Bluetooth or copy-paste to other devices with a cable (Android only). Storing data in the
cloud is a great way to backup as you transition from the woods to your office or lodging
while in the field and when cell coverage permits. Timberpad Pro iOS would be best suited to
email your data off with the buttons on the Tools tab or use the iCloud capacity if setup on
your device.

Instructional Videos: Help with Timberpad Pro
YouTube Channel TTimber, organized in a playlist at this link:
https://www.youtube.com/playlist?list=PLaZotM2nHrOQybWg8b52w1n5MFlY0uAut

Video Number
1. Timberpad Pro Overview: Introducing iOS
2. Timberpad Pro iOS Video 1: Layout and Overview
3. Timberpad Pro Android Video 1: Layout and Overview
4. Timberpad Pro Android Video 2: Exploring the Tally Tab
5. Timberpad Pro Android Video 3: Entering Data with the Tally Tab
6. Timberpad Pro Android Video 3B: Tallying in Saw-Pulp Height Mode
7. Timberpad Pro Android Video 4: Exploring the Tools Tab
8. Timberpad Pro Android Video 5: Exporting and Importing Data
9. Timberpad Pro Android Video 6: Exporting Files and the TallTimber Processor
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